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Disclaimer 

・ You may not copy or reproduce part or all of the manual provided with it without express 

permission from SATO CORPORATION. 

・ The contents of this manual are subject to change without notice for correction and 

improvement. 

・ SATO CORPORATION cannot accept responsibility for the results of using this manual. 

・ Every effort has been made to ensure the content of this manual is correct, but please 

contact us if you have any questions or concerns. 

 

・ SATO, the SATO logo, and Multi LABELIST are trademarks or registered trademarks of 

SATO CORPORATION. 

・ Microsoft and Windows are registered trademarks of the Microsoft Corporation in the United 

States. 

・ Other company names or product names used in this manual are the trademarks or 

registered trademarks of their respective companies. 
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1: File Printing 

 

 

Multi LABELIST V5 has many convenient printing functions. 

Let’s practice how to set up these functions for printing. 

 

1. What Is File Printing? 

File printing is a function to prepare the data to be printed in advance as a file and to print them by 

importing the file data without inputting the required data in the input item when printing the layout. 

*File format supports both fixed length and variable length (separation characters can be set 

arbitrarily). 

 

2. File Format Settings 

Create a layout in advance as shown below. 

 

Printer model : CL4NX-J 08 

Paper size : 45mm×70mm (Length x Width) 

Input variable : “Employee No.” 4 digits 

  “Name” 20 digits 

  “Department name” 20 digits 

Layout name : External file.mllayx 

 

 

 

 

Display the “Input Definitions” screen, move the input item from the header section to the row 

section, and arrange them in the order shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

Employe

e 

number 
Depart

ment 

name Name 

Employee No. 

Department  
name 
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Then set the file information to be imported. 

 

On the Input Definitions screen in MLDesign, click “File Format” on the “Home” tab, and the screen 

shown below is displayed. 
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(1) File name 

 Click the Browse button and select the file to be imported. 

 

(2) Variable length/Fixed length 

 Select either “Fixed length” or “Variable length”, depending on the file format to be imported. 

 

(3) Mode 

 Enable or disable “Set automatically”. For advanced settings, disable the setting. 

 

(4) Advanced settings for type 

 For Variable length, “File format” and “Quotation character”, 

 for Fixed length, “No. of record digits” and “Character code” can be set. 

* If “Set automatically” (3) is enabled, the items displayed in gray cannot be set.  

If you wish to make your own settings, disable “Set automatically”. 

 

 

 

(1) 

(2) 

 

(3) 

(4) 
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3. Access from File 

Let’s import a file on the Print screen in MLPrint. 

In this section, describe the procedures using a CSV file shown below. 

 

 

■ File Format Setting values 

(1) File name : (full path name) + Staff data.csv 

(2) Variable length/Fixed length : Variable length 

(3) Mode : Set automatically 

(4) Advanced settings for (3) : Comma-separated (.csv) 
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Start the MLPrint screen and click “File”. 

  

 

Up to now, each item had to be entered manually… 

Now the data saved in the Staff data.csv file can be imported based on the File Format Settings.

 

 

 

This completes “1: File Print”. 

  

The File Print Function can import the data. To print the data, click the Print button. 

To print automatically, refer to “3: Auto Print”. 
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Useful Functions 

 

1. Filter Function 
To print the data narrowed down by conditions, use the filter function described below. 

Using the data entered for “Employee No.” as a search key, a search is performed for the data to be 

printed. 

 

Enter the value for searching at the top of each item. 

 

 

Data are narrowed down and displayed that match the input value in front. 

 
 

A wildcard can be specified only at the top. 

“%” or “_”: Character strings of one or more characters 

 

For example, entering “%310” or “_310” enables the system to filter data that partially include “310” 

(partial match). 
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2: Sort Printing 

 

 

1. What is Sort Printing? 

Sort printing is a function to print multiple layouts on a single print screen by sorting them 

automatically. To set this function, use “Define sort” in “MLSort”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

■ Preparations 

Create two layouts as shown below, remembering the practice up to now. 

 

Printer model : CL4NX-J 08 

Paper : 45 mm x 70 mm (Length x Width) 

Layout name : Sort1.mllayx 

 

Design screen Variables screen 

 

 

 

D
e
fin

e
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o
rt 

Sort file 

 

Layout  

1 

Layout 

2 

Layout 

3 

S
o
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Sets multiple layouts 

in one sort item. 

Divides one sort item 

into multiple layouts 

and prints them. 

Layout 

1 

Layout 

2 

Layout 

3 
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Printer model : CL4NX-J 08 

Paper : 45 mm x 70 mm (Length x Width) 

Layout name : Sort2.mllayx 

 

Design screen Variables screen 

 

 

Could you make the layouts? 

Then set the define sort.  

 

 

2. Setting the Define Sort and Input Assignment 

Select Windows Start Menu > All Programs > Multi LABELIST V5 . 

 

Click the “Item Assignment” button. 
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The “Item Assignment” screen is displayed. 

Check the “Auto create” check box and click the “Add” button. 

 

 

Select “Sort1.mllayx” and click “Open”. 
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Then click the “Add” button, select “Sort2.mllayx” that has been registered, and click “Open”. 
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Does the screen shown below appear? 

If it appears, click “OK”. 

  

 

The Sort item is added and the items are placed on the Input Definitions screen. 
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■ Item assignment using Auto create 

When a layout is added with “Auto create” enabled, items for “Sort item” are added and items for 

each layout and sort items can be assigned automatically. 

 

 

For “Sort1.mllayx” and “Sort2.mllayx”, “Product name”, “Product number”, and “Lot No.” that have 

been set as Input items on “Sort1” being added to “Sort Definition Items”, each input item is 

assigned to the Sort item having the same name. 

 

 

 

When “Sort2” is added, “Product name” and “Product number” that have been set as input items in 

“Sort Definition Items”, are assigned. 

 
 

 

If “Auto create” is disabled, make these settings manually, using the “Copy Selected” or “Assign 

Selected” buttons. 
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3. Layout Judgement 

After sort definition and input assignment, make settings for layout judgement items. 

This designates the key item for sorting layouts. 

In this practice, make settings to print “Sort1.mllayx” for the input “Product number” 00001 and 

“Sort2.mllayx” for the input “Product number” 00002. 

 

 

Click the “Judgment Definition” button to open the “Layout Judgment Definitions” screen. 

 

 

 

When the “Layout Judgment Definitions” screen is displayed, click the input column of “Item name”. 
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Select a product number from “Sort item” and click “OK”. 

 

 

 

The Product number is added to the Judgment items.  
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Select “Sort1” from Layout. 

Then press the Enter key for entering the judgment value. 

 

 

 

Enter “00001” as the judgment value. 
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Select “Sort2” from Layout. 

Then press the Enter key for entering the judgment value. 

 

 

 

Enter “00002” as the judgment value. 

 

 

After entering the judgment values, click “OK”.  
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4. Settings Sort Items 

Make settings for Sort items. 

 

A print quantity item is necessary for sorting. 

Add the print quantity item here. 

 

Click the “Add” button. 

 

 

 

Enter the Item name and the number of digits of Print quantity, designate the layout location of the 

added items (header or row), and check “Print quantity item”. 
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Could you make settings as shown below? 

Check that the “Print quantity” is displayed in red. 

 

 

 

When the item settings are complete, click “ ” (Save) to save a created sort file named as “Sort 

Practice”. 

Click the “ ” (Exit) button. 
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5. Sort Printing 

Double-click the “Sort Practice.mldenx” file saved before to start MLPrint. 

Check that the layouts are sorted and printed by printing the Sort file created in MLSort. 

 

 

The Sort Print screen is displayed. Enter the items. 

 

  



Multi LABELIST V5 Training Manual - Various Printing Methods

 

 

Multi LABELIST V5   24 

6. Checking the Print Results 

Enter “00001” in “Product No.” and print “Layout 1”. 

 

 

Enter “00002” in “Product No.” and print “Layout 2”. 

 

 

Did they print successfully? 

This completes “2: Sort Printing”.  
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3: Automatic Printing 

 

 

Let’s try automatic printing using a sample layout. 

 

1. What Is Automatic Printing? 

Automatic Printing is a function to start the print program of Multi LABELIST V5 with an external 

application, such as a user program or Microsoft Windows [Run], to give parameters and to 

implement the operations according to the parameters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

■ Format 

 

* The underscore (“_”) represents a single-byte space. 

 

(1) Execution program path 

 Specify the full path. 

 

 If the installation directory has not be changed, the path is as described below. 

  32bitOS : C:¥Program Files¥SATO¥MLV5¥MLPrint.exe 

  64bitOS : C:¥Program Files(x86)¥SATO¥MLV5¥MLPrint.exe 

 

(2) ML file path 

 Specify the layout file (*.mllayx) or sort file (*.mldenx) with the full path. 

 

 

  

“(1) Execution program path”_“(2) ML file path”_Parameter_“(3) Parameter setting value” 

Execute with shell function 

from application. 

Execute by command from 

batch file 

 

SATO printer 

Print 

Execute with link from shortcut 

 

Layout file 

Data file 
Import 
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(3) Parameter setting value 

 Specify the setting value according to the parameter. 

 Some parameters do not need the setting value. 

 

* For customers who moved from Multi LABELIST V4 

For printing, add a new parameter Start Printing “/O”. 

“C:¥Program Files¥MLV4¥LPrint.exe”_“C:¥Layout.mllay”_/g_“C:¥Sample.csv” 

=>“C:¥Program Files¥SATO¥MLV5¥MLPrint.exe”_“C:¥Layout.mllayx”_/g_“C:¥Sample.csv”_/o 

 

Change the quotation characters for specifying output (/V, /D) from [ ] to “”. 

“C:¥Program Files¥MLV4¥LPrint.exe”_“C:¥Layout.mllay”_/v[SATO CL4NX]_/g_“C:¥Sample.csv” 

=>“C:¥Program Files¥SATO¥MLV5¥MLPrint.exe”_“C:¥Layout.mllayx”_/v_“SATO CL4NX”_/g_“C:¥Sample.csv”_/o 

 

■ Parameter List 

Specification Function Parameter Operation 

Specify data 

Import a file /G (g) The MLPrint screen starts and the specified file is imported. 

Import data /I(i) The MLPrint screen starts and the specified data are imported. 

Specify Operation 

The Print screen is displayed. No 
For no operation specifying parameters, the print screen is 

displayed. 

Start Printing /O(o) Print processing is done. 

Print preview /P(p) The print preview screen is displayed. 

Specify output destination 

Follow the Layout file. No 
For no output destination parameters, use the output destination 

specified by the Layout file. 

Specify a printer driver. /V(v) Use the specified printer driver. 

Specify setting file 

* Sort file only 
/D(d) 

Specify the printer driver for each layout, using the setting file. 

Specify Options 

Reference-Only mode /K(/k) Open a layout with Reference-Only mode. 

Specify tax rate /Z(/z) Specify the tax rate when printing 

 

Details on the functions of each parameter are described below. 

Although the parameters are written in uppercase, lowercase may also be used. 

All parameters for which no layout or sort file is specified will be ignored. 
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■ Specify data 

Import a file: /G parameter 

・ The specified file is imported, MLPrint starts, and the data are imported. 

・ If this parameter is used in conjunction with the /I parameter (import data), only this 

parameter is processed and the /I parameter is ignored. 

・ This parameter is ignored if the specified file does not exist. 

 

Import data: /I parameter 

・ The specified data are imported, MLPrint starts, and the data are called. 

・ If this parameter is used in conjunction with the /G parameter (import File), this parameter 

setting is ignored and the /G parameter is processed. 

・ This parameter is ignored if the specified data do not exist. 

 

■ Specify Operation 

Start Printing: /O parameter 

・ Start MLPrint using the specified layout file (sort file) and start printing. 

・ This is used in conjunction with the /G (specifying an external file) or /I (specifying internal 

data) parameter. 

・ If this parameter is used in conjunction with the /P parameter (print preview command), only 

this parameter is processed and the /P parameter is ignored. 

 

Print preview: /P parameter 

・ The print preview screen is displayed. 

・ This is used in conjunction with the /G (specifying external file) or /I (specifying internal data) 

parameter. 

・ If this parameter is used in conjunction with the /O parameter (print start command), this 

parameter is ignored and the /O parameter is processed. 

 

■ Specify output destination 

Specify a printer driver.: /V parameter 

・ Specify the name of the output printer driver. 

・ This is used in conjunction with the /G (specifying a file) or /I (specifying data) parameter. 

・ Used in conjunction with the /O (print start). 

・ If this parameter is used in conjunction with the /D parameter (specify a setting file), only this 

parameter is processed and the /D parameter is ignored. 

・ This parameter is ignored if the specified destination does not exist. 

・ An example of specifying a parameter for the printer driver is as described below. 

Sort file : C:¥ML¥Test.mldenx 

External file : C:¥ML¥Text.txt 

Output destination of printer driver : SATO SG408 

  
“C:¥Program Files¥MLV5¥MLPrint.exe” “C:¥ML¥Test.mldenx” /G “C:¥ML¥Text.txt” /V “SATO SG408” /O 
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Specify a setting file: /D parameter *Sort file only 

・ Specify the setting file path to which the output destination for each layout has been set. *1 

・ This is used in conjunction with the /G (specifying a file) or /I (specifying data) parameter. 

・ This is used in conjunction with the /O (print start) parameter. 

・ If this is used in conjunction with the /V parameter (specify a printer driver), this parameter is 

ignored and only the /V parameter is processed. 

・ If the specified file does not exist, this parameter is ignored. 

・ An example of specifying a parameter of the output destination file is as shown below. 

 Sort file : C:¥ML¥Test.mldenx 

 External file : C:¥ML¥Text.txt 

 Output destination file : C:¥ML¥Out.txt 

  

 

*1 Setting file format (Tab-separated text) 

・ If no layout file or driver name exists, the data is output from the default output destination of 

the layout file. 

・ Specify the layout name and driver name for each record. 

Layout name 

(With full path including extension) 

Tab 

(09h) 
Driver name 

CR / LF 

(0Dh/0Ah) 

 

■ Specify Options 

Reference-Only mode：/K parameter 

・ A layout file opens in the Reference-Only mode. 

・ This is used in conjunction with the /O (print start) parameter. 

・ In Reference-Only mode, multiple layout files can be used at a time, but the information 

(Sequence number settings, Save sequence number of Local variable, Output destination 

settings, File format settings, Print action settings, and Print settings) changed in printing 

cannot be saved. Especially when Save sequence number is used, do not use 

Reference-Only mode. 

 

Specify tax rate: /Z parameter 

・ Specify the tax rate when printing from 0.0 to 100.0. 

・ This is used in conjunction with the /O (print start) parameter. 

・ When the tax rate is specified with this parameter, the tax rate set by tax editing (user’s tax 

rate or fixed value) will not be used. 

  

“C:¥Program Files¥MLV5¥MLPrint.exe” “C:¥ML¥Test.mldenx” /G “C:¥ML¥Text.txt” /D “C:¥ML¥Out.txt” /O 
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2. Creating a Shortcut 

In this section, it is described how to create a shortcut icon for importing an external data named 

“Sample.csv” into layout file named “Layout.mllayx” and printing it automatically. 

 

• These two files are assumed to be saved in C:¥TEST. 

• External file format settings are required in advance according to the imported data. 

(For setting method, refer to “1: File Print - 2. File Format Settings”.) 

 

First, create a shortcut of the print program. 

 

Select “MLPrint.exe” in “C:¥Program Files¥SATO¥MLV5” folder. 

Select “Copy” from the right-click menu. 
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Then move the mouse to the desktop and select “Paste shortcut” from the right-click menu. 

 

 

A shortcut to “MLPrint.exe” will be created on your desktop. 

 

 

Select the created shortcut and open the properties from the right-click menu. 
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The “MLPrint.exe-Shortcut Properties” screen is displayed. 

The full path to the Print program is displayed in Target. 

 

 

 

Add “Layout file name”, “Parameter”, and “External file name” after “C:¥Program 

Files¥SATO¥MLV5¥MLPrint.exe”. 

 

Finally, the Target will be as shown below. Click “OK”. 

 

* The underscore (“_”) represents a space. 

 

  

“C:¥Program Files¥SATO¥MLV5¥MLPrint.exe”_“C:¥TEST¥Layout.mllayx”_/g_“C:¥TEST¥Sample.csv”_/o 
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3. Using the Shortcut 

Double-click the shortcut you created and the printing will start automatically according to the 

specified parameters. 

 

 

 

Did they print successfully? 

 

This completes “3. Automatic Printing”. 
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4: Preset Print 

 

 

1. What is Preset Print? 

Preset Print is a function to register the print contents in advance and to print them by accessing 

the data with the Access key instead of entering data when printing. Accessed data can be 

collected and printed together. 

 

 

 

 

 

 

 

 

 

■ Preparations 

Create a layout as shown below, remembering the practice up to now. 

Printer model : CL4NX-J 08 

Paper : 45 mm x 70 mm (Length x Width) 

Layout name : Preset.mllayx 

 

 

  

Preset 

Data 

MLPreset 

Registration 

MLPreset 

Print 

Access key 

Layout file 

Data 

Access key 

Data 

Data 
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2. Preset Data Registration 

First register the data to be printed. 

 

Select Windows Start Menu > All Programs > Multi LABELIST V5 > . 

 

 

After entering password, select the layout to which the print data is to be registered. 

In this practice, select “Layout.mllayx”. 

 

 

 

The MLPresetMaintenance screen appears. 
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Then let’s register the print data. 

 

Enter the Access key. The Access key is an item used for printing as a key. 

 

 

 

Enter the print data in each input item. 

On the “Print preview” screen on the right, the print image can be previewed. 

 

  

001 
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Click the “Registration” button to register the data. 

 

 

Then register some data with the procedures above. 

 

When registration ends, save the preset data. 

Select "Save Preset Data " from the File menu. 

 

 

From the File menu, select Exit to finish MLPresetMaintenance. 

 

Then access the registered data and print them with MLPresetPrint.  
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3. Preset Print 

Select Windows Start Menu > All Programs > Multi LABELIST V5 > MLPreset > . 

 

The MLPresetPrint screen appears. 

 
 

Enter “Access key” and the data filtered by the entered key are displayed on the list. 

Using the pull-down button, the list can be displayed and the data can be selected. 

Click “OK” to define the data to be accessed. 
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The corresponding data is accessed and displayed. 

 

 

 

Click the “Print Access” button to print. 

 

 

The above procedures are basic operations for preset print. 

On the following pages, let’s practice reserving the print data in advance and printing them. 
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4. Preset Reserved Printing 

Access multiple print data and reserve them for printing together. 

 

Click the "Edit" tab to switch the ribbon view. 

 

 

 

Enter the Access key to access the print data then click the "Reserve” button. 

Repeat this operation to reserve data to be printed. 

Then let's register several data. 
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Display the “Home” tab and click the “Lists” button. The list of reserved data is displayed. The 

reserved data can be checked. On the list, reserve data can be registered. 

 

 

 

When reservation is complete, click the “Reserved Printing” button to print. 

 

 

Did they print successfully? 

 

This completes “4: Preset Print”.  
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5: Folder Watch Print 

 

 

1. What is Folder Watch Print? 

Folder Watch Print is a function to print data by placing the data file in a folder that the MLV5 is 

watching periodically. File format supports both fixed length and variable length (separation 

characters can be set arbitrarily). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Top application 

Application, such as ERP package, 

application DB, that can print the data file 

Layout file 

Label design information created by 

MLV5 

Create 

Print data 

Fixed length 

Variable length  

(CSV, TXT, PRN, etc.) 

Watch folder 

Folder to be watched 

Multi LABELIST V5 

Watches the folder periodically, imports 

the print data, inserts them into the 

layout, and prints the label. 

Import 

Watch 

Import 

SATO printer 

Color printer 

Only when Plus edition 

is used 

Print 
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■ Preparations 

Let’s create two layouts as shown below, remembering the practice up to now. 

Printer model : CL4NX-J 08 

Paper : 45 mm x 70 mm (Length x Width) 

Layout name : Watch1.mllayx 

 

 

Design screen Variable screen 

 

 

File format (Refer to File Printing) 
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Printer model : CL4NX-J 08 

Paper : 45 mm x 70 mm (Length x Width) 

Layout name : Watch2.mllayx 

 

 

Design screen Variables screen 

 

 

 

 

 

 

 

 

 

File format (Refer to File Printing) 

 

 

Could you make the layouts? 

 

Then set the folder watch. 
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2. Setting the Folder Watch 

As the basic operations of Folder Watch Print, make watch settings and print under the conditions 

below. 

 Watch folder : C:¥sato¥watch 

 Layout : Watch1.mllayx 

 Data file : data1.csv 

 Output destination : SATO Lesprit408v 

 

Select Windows Start Menu > All Programs > Multi LABELIST V5 . 

 

 

Click “Yes” on the User Account Control screen. 

 

 

Enter your password. 
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Select “Watching Settings” from the menu on the left and click “Set folder and network watching.” 

 

 

Watching Settings (MLWatch Setting Tool) starts.  
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Then let’s make folder watching settings. 

 

Select a watch folder. 

* Do not set a folder on the network (shared folder starting with ¥¥ or mapped network drive, etc.) to the watch 

folder. An unexpected trouble may occur on watching folder or printing label. 
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Enter “*.csv” in Data File to be watched. 

 

 

Select a layout. 
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Select an Output Destination. 
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Check that no error is displayed on the Folder List and click “Start” in Service. 

 

 

 

 

When the status shows Executing, watching folder action works normally. 
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Place the data file in the Watch folder and print them. 

 Data file: data1.csv 

 

 

  

 

The above procedures are basic operations for Folder Watch Print. 

 

On the following pages, let’s practice how to specify the layout or output destination by data. 

  

1234567890,00001,AAAAAAAAAA,1 

1234567890,00001,BBBBBBBBBB,1 

1234567890,00001,CCCCCCCCCC,1 
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3. Specifying Data of Layout 

A layout to be printed is changed from the fixed layout to that specified by a data file. 

For example, make settings for printing “Watch1.mllayx” when “Product number” is “00001” and 

“Watch2.mllayx” when “Product number” is “00002”. 

 

First set the layout to be used and the data to be connected (Judge key). 

 

Select “Judge layout Settings” from the Tool menu. 

 

 

Enter “00001” in Judge key. 

 

  



Multi LABELIST V5 Training Manual - Various Printing Methods

 

 

Multi LABELIST V5   52 

 

Select a layout “Watch1.mllayx”. 
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In the same way, set Judge key “00002” and layout “Watch2.mllayx” and click “OK”. 

 

 

Then set the watch method. 

 

Select [Specify by data] for Layout. 
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Click “…”. 

 

 

The Judge Field Settings are displayed. 
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Set “2” in Judge layout Item and click “OK”. 

(The layout is judged by the second item in the data file.) 

 

 

Select “Save” from the File menu to restart the service. 
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Place the data file in the Watch folder and print them. 

 Data file: data2.csv 

 

 

  

 

The procedures complete when Layout “Watch1.mllayx” and “Watch2.mllayx” are printed. 

 

 

 

 

  

1234567890,00001,AAAAAAAAAA,1 

9999999999,00002,1 

1234567890,00001,CCCCCCCCCC,1 

 



Multi LABELIST V5 Training Manual - Various Printing Methods

 

 

Multi LABELIST V5   57 

4. Specifying an Output Destination by Data 

An output destination can be changed from the fixed printer driver to the method specified by a data 

file. 

For example, set up a new item for a data file [Printer Judge Number] and make settings for the 

method to print with “SATO Lesprit408v” for “PR1” and “SATO Lesprit408v (1 copy)” for “PR2”. 

 

First set the data to be connected to the printer driver used as the output destination (Judge key). 

 

Select [Output Destination Judgment Settings] from the Tool menu. 

 

 

Enter “PR1”in Judge key. 
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Select an Output Destination. 

 

 

Set the judge key “PR2” and the output destination in the same way. 
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Click “OK”. 

 

 

Then set the watching method. 

 

Select [Specify with data] for Output Destination. 
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Click “…”. 

 

 

The “Judge Field Settings” screen is displayed. 

(If the setting of Layout is [Use Fixed Layout], the [Output Judge Field Settings] screen is 

displayed.)  
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Set “5” in [Output Destination Judgment Items] and click “OK”. 

(The output destination is judged by the fifth item in the data file.) 

 

 

Select “Save” from the File menu to restart the service. 
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Place the data file in the Watch folder and print them. 

 Data file: data3.csv 

 

 

  

 

When data are printed from two Output Destination, driver setting is completed. 

 

Printer set for “PR1” Printer set for “PR2” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This completes “5: Folder Watch Print”. 

  

1234567890,00001,AAAAAAAAAA,1,PR1 

9999999999,00002,1,,PR2 

1234567890,00001,CCCCCCCCCC,1,PR2 

5555555555,00002,1,,PR1 
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Useful Functions 

 

1. Specifying Wildcards for the Data File name 
For setting the Folder Watch, wildcards can be used when specifying the data file name. 

“*” : Character strings of one or more characters 

“?” : Any single character 

 

 

■ Example of Use 

Setting example Description Applied file name 

*.csv All files with extension .csv data1.csv, test1.csv, etc. 

a-*.txt A file name beginning with “a-” with extension .txt a-test.txt, a-001.txt, etc. 

data-???.dat 
A file name “data-” + any 3 characters with 

extension .dat 

data -001. dat, 

data-m83.dat, etc. 

out????.* All files whose name is “out" + any 4 characters out0001.txt, out-abc.csv, etc. 
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2. Importing and Exporting the Setting Value 
The values set by Watching Settings (MLWatch Setting Tool) can be imported from a file or 

exported to a file. Use this function when replacing your computer or using the same setting values 

on multiple computers. 

  

 

3. Log Check and Log Level 

On Folder Watch Print, the trouble information generated during watching, such as file analysis 

error, is always output to an event log. For normally processed information, it is output by changing 

“Log level:” to “Information / Warning / Error”. 

 

For output contents of the log, check “Help” of MLmaintenance. 

  

An event log starts and the contents of the log can be checked. 
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4. Data Backup 

Data files used for Folder Watch Print can be backed up. 

 

 

Backup data for a data file are saved for each row of watched settings separately. 

(CommonAppData)¥SATO¥MLV5¥MLWatchPrintHistory¥Folder[row number of the folder Information List] 

Example: C:¥ProgramData¥SATO¥MLV5¥MLWatchPrintHistory¥Folder5 

 

File name is automatically set from [Analysis date of data file] and [Data File Name]. 

It will be automatically deleted after the specified retention period has passed. 

 

5. Specifying the Cut Timing 
For Folder Watch Print, a cut operation is done for each record according to the setting of layout. 

To cut after printing multiple records, specify “EjectCut”, data for cut or file unit cut. 

 

• Cut operation for 1 record 

For print action settings of a layout file, set it by timing of eject cut and cut operation. 

# Layout file Cut operation 

Print Action Settings-Others [Use Eject Cut] 

1 Enable (Check) Cut for each record unit. To cut at any timing, use “EjectCut”. 

2 Disable (Not Checked) Follow the settings of the print operation below. 

Print Action Settings-Print action “Timing for sort mark print or cut operation” 

3 No 
No cut if the operation mode of the printer is continuous print, 

For a cutter, cut for each sheet. 

4 Disable No cut 

5 Cut for each row Cut for each record unit. 

6 Cut for each page 

Cut for each record unit. To cut at any timing, use “EjectCut”. 7 
Perform each time the value of the 

corresponding item changes 

8 Perform each time print command 

9 Perform each time specified quantity Cut for the unit of specified quantity and cut the last of fraction. 
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• Use of EjectCut record 

 If a record for “EjectCut” only is created in a data file, you can cut at any place. 

 To use “EjectCut”, set Eject Cut of Layout file to disabled (#2) and Cut operation also to disabled 

(#4). 

 For a data file of fixed length, fill the space to the number of digits of record on which “EjectCut” 

is to be specified. If the number of digits is not filled, an incorrect number of digits occurs and an 

error is generated for the following data. 

 

 

 

 

 

 

 

• Cut for each file 

 When [Cut by file] is enabled for eject cut for a set print operation of watched settings, the label 

can be cut at the end of the data file. 

  

 

 To cut by file, set Eject Cut of Layout file to disabled (#2) and Cut operation also to disabled (#4). 

 

 When Output destination is set to [Specified by Data], the label is cut for the output destination 

specified by the record at the end of a data file. For output destinations that are not specified by 

the record at the end, cut is not performed. 

 

  

"ST312R","19000","490310041310","Meguro head office","2" 

"PW208","15000","490310841310","Meguro head office","1" 

EjectCut 

"RT308R","9500","490310413108","Meguro head office","1" 

EjectCut 

 
PW208 

||||||||||||| 
490310041310 

ST312R 

||||||||||||| 
490310041310 

ST312R 

||||||||||||| 
490310841310 

RT308R 

||||||||||||| 
490310413108 
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6. Output to Multiple Printers 
When printing on multiple printers, Folder Watch Print can specify whether to print in record units 

with the print data or by file with Watch Condition (file name or folder). 

 

• Specifying multiple output destinations for one file 

 As output destination can be specified by record of a data file, specify multiple printers in order, 

and output data to printer effectively. As for the setting method, refer to “Specifying an Output 

Destination by Data”. 

 

• Specifying one output destination by one file 

 When data to judge the output destination cannot be specified in the record of a data file, set the 

file name or folder of the data file by Watching Settings for each output destination, and the data 

will be output to multiple printers.  

 

 Specifying an output destination with a file name 

  

 

 Specifying an output destination with a folder 

  

 

 When the number of print quantity or print frequency is high, printers not used for printing will be 

in standby status while printing a data file. To increase the printing speed, enable “Multi-thread: 

Use” and multiple data files will be processed at a time. 

 

 

 

 

 

 

 

 

 

Analyis・Printing PR1_001.csv 

PR2_001.csv 

PR3_001.csv 

Standby 

Standby 

PR1_001.csv 

PR2_001.csv 

PR3_001.csv 

Analyis・Printing 

Analyis・Printing 

Analyis・Printing 
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• The number of printers that can be set 

The recommended number of printers for one PC is up to 30 for Plus, Standard, and Lite, and up 

to 50 for Enterprise. Please note that if the number of printers exceeds the recommended 

number, the processing speed may be affected. 

Data file Setting method 

Maximum number of printers 

Plus·Standard·Lite / Enterprise 

Single thread Multiple threads 

Specify multiple output destination for one file. Record 
30 / 50 

Expansion 100 / 500 
- 

Specifying one output destination by one file. 
File 100 / 500 10 / 50 

Folder 100 / 500 10 / 50 

 

7. Changing the Start Method for Folder Watch 
Folder Watch Print runs as Windows service. 

Change the Startup type to set the start method of Folder Watch. 

 

 

Type of startup Operation at settings 

Automatic Folder Watch function starts at OS startup. 

Manual 
Folder Watch function starts only when the “Start” button is pressed. It does not start 

automatically. 

Disable 
The Folder Watch Print function is not used. The Folder Watch function does not start 

even if the “Start” button is pressed. 

 

* If the Folder Watch function does not start automatically at OS startup 

It is confirmed that Folder Watch does not start even if “Auto” is set on Windows Server 2008 R2 

depending on the startup timing of the OS. If startup fails with “Auto” setting, select Service in 

“Administrative Tool” from the “Control Panel” and change the type of startup to “Auto (Delay start)”. 
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8. Printing data whose print quantity has not been specified 
If the top application cannot output the print quantity in data, a function that prints one for each 

record can be used. 

 

• Printing one for one record 

 Open the layout file in MLPrint or MLDesign and change the setting of “Print Quantity” of input 

items in Field Definitions on File Format Settings. For the variable length file, set the item 

number to “0”. For Fixed- length file, set the Start position and End position to “0”. 
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6: ODBC Data Import 

 

 

1. What is ODBC Data Import? 

ODBC Data Import is a function to import data required for printing from a database with the ODBC 

connection. 

This function enables you to use the existing database or to import data by modifying part of data 

file. 

 

■ Preparations 

Create a layout in advance as shown below. 

 

Printer model : CL4NX-J 08 

Paper size : 45mm×70mm (Length x Width) 

Input variable : “Employee number” 4 digits 

  “Department name” 20 digits 

  “Name” 20 digits 

Layout name : ODBC Practice.mllayx 

 

 

 

 

 

Display the “Input Definitions” screen and move the Print Quantity from the row section to the 

header section. 

 

  

Employe

e 

number 
Depart

ment 

name Name 

Employee number 

Department name 

Name 
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2. ODBC Driver Settings 

Create a data file and ODBC driver used for the ODBC connection. 

 

In this section, the procedures for using a CSV file shown below are described. 

At the top, a header row is prepared. 

It will be used for item settings of the ODBC connection. 

 

File name : Staff Data.csv 

Destination : C:¥sato 

 

 

Create a ODBC driver. 

Select “Administrative Tools” from “Control Panel” then “ODBC Data Sources”. 

(For a 64-bit OS, select “ODBC Data Sources (32-bit)”) 

 

Click the “Add” button. 
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Select “Microsoft Text Driver (*.txt; *csv)” and click “Finish”. 

 

 

* When an ODBC driver (Excel, Access) does not exist  

Download it from the Microsoft official site and install it. 

https://www.microsoft.com/ja-jp/download/details.aspx?id=13255 

For another ODBC driver, obtain it from the manufacturer. 

 

Enter “ODBC Practice” in “Data Source Name” and click “OK”. 

 

 

 

  

https://www.microsoft.com/ja-jp/download/details.aspx?id=13255
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When it is added to the list, driver setting is completed. 
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3. ODBC Connection Settings 

Then let’s make the settings for the ODBC connection to import data on the MLPrint screen. 

 

Start the MLPrint screen and select “ODBC Connection Setting”. 

  

 

Click “Connect”. 
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Select “ODBC Practice” on the “Machine Data Source” tab and click “OK”. 

 

 

Select a folder in which the “StaffData.csv” file is saved and click "OK". 
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The data file “StaffData.csv” is displayed on the list. 

 

 

Specify the field name related to the input items. 

(As the field name, the title line of the data file is automatically imported.) 

Input item name of layout file Filed name of data file 

Employee number Number 

Department name Department 

Name Name 

 

 

 

 

 

  



Multi LABELIST V5 Training Manual - Various Printing Methods

 

 

Multi LABELIST V5   77 

 

Specify the extraction condition and click “OK”. 

• Extraction condition  

To extract data for the entered employee number (department name and name) 

  Field name : Number 

  Type : Numeric 

  Comparison condition : = 

  Comparison target : Input item 

  Comparison data : Employee number 
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4. Access from ODBC 

Then let’s import data on the MLPrint screen, with the ODBC connection. 

 

Enter “9990” in “Number” and click the “ODBC” button. 

 

 

The department and name of an employee whose number is “9990” are imported from the 

StaffData.csv. 

 

 

This completes “6. ODBC Data Import”. 

 

To get more out of ODBC data importing, refer to “Useful Functions”. 
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Useful Functions 

 

This section introduces functions useful when importing ODBC data. 

 

1. Importing ODBC data automatically 
If an extract condition is specified, the ODBC data will be automatically imported when input to the 

specific input item is completed. One step of pressing the “ODBC” button can be skipped. 

 

Enable “Auto read settings” on the ODBC Connection Settings screen and specify the input item to 

be linked. 
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Press the Enter key to finish input and the ODBC data is imported automatically and are reflected 

on the screen.  
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2. Importing all data with the ODBC connection 
If an extraction condition is not specified on the ODBC Connection Settings, all data is imported by 

clicking the “ODBC” button. 

 

To import all data when an extraction condition is specified, set the extraction condition for type to 

“Character” and comparison condition to “like” in “Import target” on the ODBC Connection Settings 

screen. 
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Enter “%” in the input item of comparison data on the Print screen, and all data can be imported. 

 

 

   When ODBC data are imported... 

 

 

 

 

The data is imported on a separate page for each record of the data file. 

For the layout with the row section, data that have common header information are printed on a 

single page. 
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3. Processing the imported data 
Data processing, such as importing data in multiple fields into a single input item, is available by 

modifying the SQL statement.  

 

For example, the target data has “Year”, “Month”, and “Day” fields and the processed data is to be 

imported in the input item “Date”. 

 

 

 

On the ODBC Connection Settings screen, enter the field name “Data” in the input item “Date” and 

click “Display SQL”. 

 
 

Enter the text below in the SQL statement between SELECT and FROM. 

"Year" & '/' & "Month" & '/' & "Day" AS "Data" 
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Format Content 

“(Field name)” Specify the field name to be imported. 

(A) & (B) Join the character string. 

‘(Fixed value)’ Enter a fixed value. 

(A) AS (B) The value (A) is treated as (B). 

 

The above SQL statement means that the data imported from “Year”, “Month”, and “Day” are joined 

with “/” and treated as the field name “Data”. 

 

Click “Test”. If the date is imported, this setting is completed. 
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